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Introduction 
Knowing how to use all of the CAD tools that Chief Architect has to offer is important because you 
will need them to draft all of the detail drawings needed in a set of residental building plans. You were 
introduced to CAD in Chief Architect in the book, “Residential Design Using Chief Architect”© or in 
one of the Learning Chief Architect Step by Step books. I’m assuming that you are versed in the basic 
tools described in one of those books.  
 
Detail drawings are needed because they show a relatively small part of a building that otherwise 
cannot be clearly seen in the overall plan and in the elevation drawings. In order to see every 
component clearly, the portion of the building that is detailed is drawn in a larger scale than those 
other views, which is the same as moving closer to the components. Many building departments 
require to know how certain different building components are joined and fastened together. You will 
need to show this by making detailed drawings. 
 
Chief Architect has hundreds of detailed CAD drawings in its library, which you can use to save time. 
However, you will find that each building is different and even if you use one of Chief Architect’s 
CAD drawings you will often need to make modifications to fit your situation. 
 
There are going to be many different situations in your plan development where knowledge of Chief 
Architect’s CAD tools and capabilites will speed up your work. The more proficient you are, the more 
efficient you will become. This section will help you in achieving this goal. 
 
After reading and doing the exercises in this section you will be able to: 

• Know and understand the basic edit types in Chief Architect. 

• Set array copy intervals, angles and quantities. 

• Array copies using the distributed objects tool. 

• Use the align and distribute objects edit tools. 

• Break polylines. 

• Merge polylines that overlap. 

• Subtract polylines that overlap. 

• Use the line style editor to create new line styles. 

• Transfer line styles and layer information between plans. 

• Use the trim and extend commands. 

• Draw Revision Clouds 

• Nudge objects 

• Use Chief Architect’s new CAD block insertion point tool 

• How to display text labels for CAD objects 
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Step by Step Tutorial 
The editing of objects in Chief Architect was significantly 
changed with the introduction of Chief Architect X1. 
Beginning with Chief Architect X1 the basic CAD editing 
types were simply named basic edit types. This is because 
they consistantly apply to Chief Architect’s 3D 
architectural objects too. This chapter will review the basic 

edit types. 

You can control how you reshape CAD objects as well as many other architectural objects by changing 
the edit type. 

 

STEPS: Working with the Different Edit Types 

1. If you have Chief Architect running select File ► New Plan. If the program is not running, then go 
ahead and start Chief Architect and select New Plan from the Welcome to Chief Architect splash 

screen. Make sure that  Edit Object Parts tool is toggled off. In later versions of Chief Architect, 

this tool was replaced with the  Connect CAD Segments tool. You want this tool to be toggled 
on (you should see it highlighted with a check).  

2. Select the  Rectangular Polyline tool and draw a rectangle. Select the rectangle. Click on one 
of the corner handles and note the behavior when you move the corner around. This is the default 
edit type of behavior. You can change the edit types in several ways, which will change the edit 
behavior. 

CHAPTER 1 
The Basic Edit Types 
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3. Display the Preferences dialog. In the Edit category, click on Behaviors.  
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4. Note that the edit type can be changed by the selection you make in the Edit Type section. You can 
also set the Concentric Jump increment in this section. 

5. Click OK to close the Preferences dialog. 

Another way to change the edit type, and perhaps a more efficient 
way, is to customize your toolbars. Throughout this book, I will be 
using the Extended Tool Configuration. The Edit Modes toolbar is 
included in this configuration and displays on the right side of the 
drawing area.  

6. Select Tools  Toolbars & Hotkeys  Customize Toolbars. The 
Toolbar Customization dialog displays. Go to the Configurations 
panel. From the Active Configuration menu, select Extended Tool 
Configuration. Click the Switch To button. Close the dialog. You are 
now in the Extended Tool Configuration setup. Note the Edit 
Modes toolbar. 

 

 

The  Rotate/Resize About Current Point is not included in the default Edit Modes toolbar. This is 
a very handy tool to have.  

7. To add the  Rotate/Resize About Current Point to the Edit Modes toolbar, select Tools  
Toolbars & Hotkeys  Customize Toolbars. The Toolbar Customization dialog displays. On the 
Tools panel make sure that Plan is highlighted in the View Type drop-down window. Click in the 
Available Toolbar Buttons menu window and press the letter E. Expand Edit Behavior Tools. Find 

the  Rotate/Resize About Current Point tool and drag it into the Edit Modes toolbar. Close the 
dialog. 

8. Select the  Rotate/Resize About Current Point tool. Select the   Place Point tool. Place a 
point to the right of the rectangle that you drew. Right-click to select the rectangle. Drag the rotate 
edit handle and notice what happens. The rectangle will rotate about the point you set. Chief 
Architect will use this point until you place or select another point. 
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9. Click the  Rotate/Resize About Current Point button to toggle the tool off. Rotate the rectangle 
and note that it will now rotate about its center, which is the default behavior. 

10. Another place to change the edit behavior type is by using the Edit menu. Select Edit ►Edit 
Behaviors. 

 

11. Note that a check mark is displayed within the Default edit behavior icon. This indicates that this is 
the current edit behavior. 
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12. Select the  Concentric edit behavior. Drag one of the corner edit handles of the rectangle. The 

rectangle will resize concentrically. Notice the  graphic displayed next to the cursor. This is a 
feature introduced in Chief Architect X3 and is meant to remind you that you are using a different 
edit behavior than the Default edit behavior. 

 

13. Go back to the Edit menu and select the  Default edit behavior. You may find it best to always 
remain in the Default edit behavior mode. It will, more than likely, be the edit behavior that you will 
use the most often. You can, instead, use keystrokes to temporarily change to a different edit 
behavior. 

14. Select Edit ►Edit Behaviors. Note the keyboard shortcuts listed beside each edit behavior. For 
example, C is listed beside the Concentric edit behavior. 

15. Select the rectangle. Press the C key and drag one of the corners. The rectangle resizes 
concentrically because by pressing the C key you have temporarily switched to the Concentric edit 
behavior mode. Once you release the C key you will be back to the Default edit behavior mode. 

16. Double-click the  Concentric tool button on the Edit Modes toolbar. This is a fast way to display 
the Edit Behaviors panel of the Preferences dialog. Set the Concentric Jump to 12”. 

17. Click OK to close the Preferences dialog. 
18. Select the rectangle. Drag a corner. The rectangle resizes in concentric jumps of 12”.   

19. Click the  Copy/Paste edit button. Drag a corner, slowly, and a concentric copy that is 12” from 
the original rectangle will generate in the direction that you dragged.  

20. To make more than one copy, click the  Copy/Paste edit button, and then click the  Sticky 
Mode edit button that becomes available. Now you can make as many copies of the original 
rectangle as you want in this manner. All of the copies will be generated concentrically at precisely 
12” from the previous copy. Try making at least three copies. Note that each time you make a copy, 
release the mouse button and then click and drag to make another copy. 
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21. You can also make concentrically multiple copies of a selected object. Press the space bar. Select the 

outermost rectangle. Click the  Multiple Copy edit button. Click the  Multiple Copy 
Interval tool button that becomes available. The Multiple Copy dialog displays. 

 

 

22. For General Objects set the Primary Offset to 30”.  
23. Click OK to close the Multiple Copy dialog. 
24. Drag the outer rectangle’s edit handle. Concentric copies, 30” apart, are generated. The concentric 

jump of 12” that you set in the Preferences dialog is ignored in this case. 
25. Display the Preferences dialog and set the concentric jump back to 0”. When this is set to 0, then 

when you change the size of an object concentrically it is going to resize to increments that the grid 
is set at.  Click OK to close the dialog. 

26. Double-click the  Select Objects button to display the General Plan Defaults dialog. 
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27. In the Snap Grid/Snap Units section, make sure that the Snap Unit is listed as 1”.  
28. Click OK to close the General Plan Defaults dialog. 
29. Select the outermost rectangle. Drag one of the edit handles and drag. The rectangle resizes 

concentrically at 1” increments. You can see this much better if you zoom in close enough so that 
the snap grid displays.  

It is good practice to leave the concentric jump set to 0”, except when you need to do something else. 

In regards to the Concentric edit behavior mode, when you drag an edge of an object (such as the 
rectangle), each edge of the object resizes to the same distance from where it was before.  

If you use the Resize behavior mode, the proportional relationships between each edge of the object is 
maintained. 

30. Select the outermost rectangle. You should still be in the Concentric behavior mode. Press the X key 
(the hot key for the Resize edit behavior) on your keyboard and drag a corner. Note that the 
proportional relationships between the edges are maintained as you drag. You can see this well if 
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your rectangle is not square. The distance each edge moves from its former position is not the same 
distance. The aspect ratio between the length and the width of the rectangle is maintained. 

31. Switch to the  Default edit behavior. This is the edit behavior you typically will want to be in. 
32. Select Edit ►Edit Behaviors. Note the keyboard shortcuts for the Alternate edit behavior. One of 

these is the right mouse button. 
33. Select the outermost rectangle. Press the right mouse button and drag a corner. The angle of the 

corner is maintained as you drag. Now press the left mouse button and drag a corner. The angle of 
the corner changes. 

You can easily learn how to switch to the different edit behavior modes by selecting Edit ►Edit 
Behaviors and observing the keyboard shortcuts for the different edit behavior modes. Note that the 
keyboard shortcut for the Fillet edit behavior is the F key. To fillet a corner of the rectangle, press the 
F key before you click and drag the corner. If you want to make a very precise fillet you would use the 

 Fillet Two Lines edit tool (Fillet Lines in newer versions of Chief Architect) or the  Chamfer 
Two Lines edit tool (Chamfer Lines in newer versions of Chief Architect). 

34. Select a rectangle by clicking on its bottom edge. Double-click the  Chamfer Two Lines edit tool. 

The Fillet/Chamfer dialog displays. For newer versions of Chief Architect, click the  Chamfer 

Lines edit tool and then click the  Set Chamfer Distance edit tool. The Set Chamfer Distance 
dialog displays. 

                                                     

35. Set the Chamfer Distance to 24”. 
36. Click OK to close the Fillet/Chamfer dialog or the Set Chamfer Distance dialog. The setting will be 

maintained until you change it. 
37. Click on the right edge of the rectangle to generate a 24” chamfer. 
38. If you have a newer version of Chief Architect, try this to chamfer all corners at the same time. Click 

the  Chamfer Lines edit tool and then click the  Chamfer All Corners edit tool. 

You will find that Chief Architect has several useful edit types. All of the edit types are collected in the 
Edit menu along with the display of their hot keys. You can select an edit behavior to make it 
permanent or you can use its hot key to temporarily use the edit behavior type. Generally, you will 
want to be in the Default edit behavior mode. You will also want to keep the concentric jump set to 0” 
unless you deliberately want to use something else. You can quickly access the setting for the 

concentric jump by double-clicking the  Concentric tool button on the Edit Modes toolbar. 
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39. Before exiting the drawing, make sure the edit behavior type is the  Default edit behavior. You 
will not need to save the drawing. 

CAN YOU DO IT? 
1.  

Draw Fig. 1.1. Use the   Draw Line tool to draw the lines. Use the chamfer tool to draw the 
chamfers. Use the fillet tool to fillet the two ends. Assume any dimensions not shown. 

 

 

 

 

Draw Fig. 1.2. Use the   Circle tool and the  Concentric edit behavior. Place the 6” dia. circles 

using the  Rotate/Resize About Current Point tool and the  Multiple Copy edit tool. 

PROBLEM ONE 

PROBLEM TWO 
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Draw Fig. 1.3. Use the   Rectangular Polyline tool. Use the   Draw Arc tool (use the  
Center, Radius, End Arc arc creation mode) to create the arc. Once you have one side of the window 

drawn, use the  Reflect About Object edit tool to paste a copy to the other side. Some 
architectural illusionism is introduced. Do not show the dimensions in your drawing. Use the 1” grid 
to determine dimensions where there are none.  

 

 

PROBLEM THREE 
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Step By Step Tutorial 
When doing mulitiple array copies, beginning with Chief 
Architect X1, you can now set copy intervals for both 
directions. You can also specify copy angles and 
quantities. So we will look at some of these features in 
this chapter. In the chapter following this chapter, you 
will learn how to array objects using the distributed 

objects tools. This was a new feature introduced in Chief Architect X2. X3 introduced two tools that 
distribute and align a group of objects, which you will also learn about.  
 
 

The drawing, D1.plan, is used in the following exercise on setting array copy 
intervals, angles, and quantities, and can be found in the X9 Expert Drawings Before folder. If you 
have an older version of Chief Architect (X3 or newer) use the D1.plan from the Older CA 
Drawings Before folder. Both of these folders are in the Advanced CAD folder. 

 

STEPS: Setting Array Copy Intervals, Angles, and Quantities 

1. Open the D1.plan. The drawing contains a tree placed inside a rectangular perimeter that 
represents an orchard. A point marker has been placed in the center of the orchard. A terrain 
feature has been placed to the left of the point marker, which you will work with later in the 
exercise.  

2. Select the tree that is located just inside the upper left corner of the orchard. Delete it. Replace it 

with a plant image from your library by clicking the  Plant Chooser tool. The Plant Chooser 
dialog will display where you can select your preferred tree, or bush, or whatever.  

3. Select the  Multiple Copy edit tool.  

4. Select the  Multiple Copy Interval tool that becomes available to display the Multiple Copy 
dialog. Note that there are two options that you can choose from, the option Offset Between 
Copies When Dragging and the option Evenly Distribute Copies When Dragging. By default the 
radio button for Offset Between Copies When Dragging is selected and it will be the one described 
first. The available choices for this option are sorted by objects. The tree would fall under General 
Objects. 

CHAPTER 2 
Setting Array Copy 
Intervals, Angles, and 
Quantities 
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5. Set 16’ for the Primary Offset for General Objects.  Set 24’ for the Secondary Offset (Alternate 
Behavior). The Primary Offset is the copy interval for the first direction that you drag and the 
Secondary Offset is the copy interval for the second direction that you drag. 

6. Click OK to close the Multiple Copy dialog. 

7. Move the cursor to the selected tree and when you see the  multiple copy graphic appear 
next to the cursor, alternate drag (click the right mouse button) and drag horizontally to the right for 
the first direction. Each copy of the tree is drawn 16’ from the previous copy. When you reach the 
right end of the orchard, release the mouse button and drag downward. Each row is drawn 24’ from 
the previous row. Click the left mouse button when you reach the end of the orchard. 

8. Take a  Full Camera perspective view of the orchard.  

       

 

9. Close the 3D view. 
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10. Click the  Undo tool button until only the original tree remains. 
11. Select the tree. 

12. Select the  Multiple Copy edit tool. 

13. Select the  Multiple Copy Interval tool that becomes available to display the Multiple Copy 
dialog. This time select the radio button for the 2nd option, Evenly Distribute Copies When Dragging. 

14. Type 16 in the Primary Number Of Copies All Objects edit box. Type 8 in the Secondary Copies 
(Alternate Behavior) edit box. 

15. Click OK to close the Multiple Copy dialog. 
16. Move the cursor to the tree until the multiple graphic appears and then alternate drag horizontally 

to the right. No matter how far you drag you will get 17 copies (not counting the original tree), 
equally spaced. Release the mouse button near the right side of the orchard and drag downward. 
Again no matter how far you drag you will get 8 rows (not counting the original row) of apple trees, 
evenly spaced. Click the left mouse button near the end of the orchard. Using this method you can 
easily lay out the orchard more evenly. 

17. Take a  Full Camera perspective view of the orchard. 
18. Close the 3D view. 

19. Click the  Undo tool button until only the original apple tree remains. 

20. Let’s try a different object type. Select the  Joist tool. 
21. Drag to draw a joist within the upper left quarter section of the orchard. Click Yes when asked if you 

would like to create a general framing member instead.  

22. Select the framing member. Click the  Multiple Copy edit tool. 

23. Select the  Multiple Copy Interval tool that becomes available to display the Multiple Copy 
dialog. 

24. Select the radio button for Offset Between Copies When Dragging. Notice that the value for the 
Primary Offset for Joists (Joists/Posts/Beams for new versions of Chief Architect) is highlighted. 
Chief Architect recognized the object type and has made the Primary Offset value for Joists 
(Joists/Posts/Beams for new versions of Chief Architect) ready to change if you wish. Notice the 
value that is listed for Rotation Of All Objects. If necessary, change this value to 15º. 

25. Click OK to close the Multiple Copy dialog. 
26. Move the cursor to the rotation drag handle for the joist and when you see the graphic appear click 

and drag to make multiple copies of the joist. The angle of 15º between each of the joists is the 
value that was set and will remain at this value until you change it. Make a complete circle of the 
joists. 
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27. Click the  Undo tool button. 
28. Select the framing member and delete it. 

You rotated the framing member about its center. Now let’s rotate an object about a current point. 

29. Select the   Place Point tool. Move the cursor to the point marker in the center of the orchard 
(zoom in as necessary) and snap a temporary point to it. Press the space bar. 

30. Select the terrain feature near the middle of the orchard just to the left of the point marker.  

31. Click the  Rotate/Resize About Current Point edit behavior tool button. 

32. Click the  Multiple Copy edit tool. Move the cursor to the rotation drag handle of the selected 
terrain feature and drag. This time multiple copies are distributed at 15º intervals around the 
current temporary point. You can also use this feature to create various objects. 

 

33. Take a  Full Camera perspective view. 
34. Close the 3D view. 

35. Click the   Undo tool button twice. 

36. This time let’s take advantage of the array copy tool. Make sure that the  Rotate/Resize About 
Current Point edit behavior tool button is still selected. Select the terrain feature. 
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37. Click the  Multiple Copy edit tool. 
38. Move the cursor to the rotation edit handle and alternate drag the terrain feature around the 

temporary point to generate multiple copies at 15º intervals. When you have made a complete 
circle release the mouse button and drag outwards away from the temporary point.  Additional rows 
of the terrain feature are created at the secondary interval that is set for general objects. 

 

As you can see, Chief Architect provides easy to use tools that allow you to make multiple copies and 
array copies of objects. 

39. Close the drawing without saving.  
 

CAN YOU DO IT? 
2.  

 

Draw Fig. 1.4. Use the  Circle tool and the   Draw Arc tool to begin the drawing (refer to 

drawing on left in Fig. 1O). Then use the  Rotate/Resize About Current Point tool and the  
Multiple Copy edit tool to draw the figure on the right. Assume the dimensions of the drawing. 

PROBLEM FOUR 
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Draw Fig. 1.5, which is a drawing of a reflected ceiling plan with light fixtures. Use the  

Rectangular Polyline tool and the  Multiple Copy edit tool to draw the figure. 

PROBLEM FIVE 
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Draw Fig. 1.6. Draw the dining table with chairs shown in Fig. 1.6. Assume any missing dimensions. 

 

PROBLEM SIX 
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Step by Step Tutorial 
The Distributed Objects tools allow you to lay out an array 
of objects within a region or along a path. You could call 
it a fast fill tool. 

The distributed object tools allow you to place an object 
from the library into an area defined by a polyline or 
spline filling the area in a synmetrical pattern. An object 
cannot be selected from within the distribution region but 

you can select the entire distribution region. The region can then be reshaped. Reshaping the region 

redistributes the objects within it. You can use the  Break Line tool to give the region a different 
shape. Again the region will redistribute the objects  

 

 

You cannot assign a group of objects within a distribution region to the library. You can select a 
distributed region and explode it. When you do this you can then select the individual objects and 
then assign them to the library. The explode operation is not reversible. 

Objects can also be distributed along a path defined by a polyline or a spline. For example, you can lay 
out a path of stepping stones, defining the spacing between the stones using the distributed objects 
path tools. You can then select the path, adjust it, and the stepping stones will be redistributed. In the 
following illustration,the lights are part of another distributed spline that follows the same path as the 
stepping stones and distributes the lights in a staggered pattern along either side of the path. 

CHAPTER 3 
Arraying Objects with 
Distributed Objects 
Tools 
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The distributed paths and regions can only use objects taken from the library. Of course, this includes 
any objects that you create and place in the library. 

In this section you will learn how to use Chief Architect’s distribution tools. We will develop the 
terrain features you see in the following illustration. 

 

 

The drawing, D2.plan, is used in the following exercise on arraying objects with 
distributed objects tools, and can be found in the X9 Expert Drawings Before folder. If you have an 
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older version of Chief Architect (X3 or newer) use the D2.plan from the Older CA Drawings Before 
folder. Both of these folders are in the Advanced CAD folder. 

 

STEPS: Arraying Objects with Distributed Objects Tools 

1. Open the D2.plan. The drawing shows a one story house with a crawl space foundation. A deck is 
attached to the rear of the house. 

2. Select Build ► Distributed Objects. There are two regional tools, the Polyline Distribution Region 
and the Spline Distribution Region. There are two path tools, the Polyline Distribution Path and the 
Spline Distribution Path. 

3. Select the  Polyline Distribution Region tool. Draw the polyline region by first snapping to the 
upper left corner of the property. Drag to draw the polyline region so that it is about ¾ of the way 
across the property and about halfway to the house. Adjust it so that it is 60’ long by 30’ deep. 

 

4. Select the polyline region.  

5. Click the  Open Objects edit button to display the Distribution Region Specification dialog. It 
opens to the Distributed Object panel. In the Current Object section, No Object Selected is 
displayed. 
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6. Click the Select button. The Select Library Object dialog displays. Expand Chief Architect Core 
Catalogs. Expand Plants, expand Trees, expand Deciduous, expand Prunus. Click on  Prunus 
domestica. Select Prunus domestica (medium) 1 (you will need to expand the dialog to see the full 
names). 

7. Click OK to close the Select Library Object dialog. 
8. Click the Edit button. The Plant Image Specification dialog displays. You should be on the Image 

panel. Note that there are a lot of things that you can change about this plum tree using this dialog. 
Let’s just change the height. Change the height to 7’. 

9. Click OK to close the Plan Image Specification dialog. 
10. Change the Object Spacing Distance to 8’. This will give you a little room between the branches. The 

Standard Grid is selected. We will leave it at that. Chief Architect X8 users can see what this looks 
like in the graphic window on the right side of the dialog. In the Object Orientation section, Angle 
does not really apply in this case. As you can see, however, you do have the ability to adjust the 
rotation of objects within the grid. You can also do some offsetting in relation to the grid by entering 
offset values in the Object Positioning section. These are easy to experiment with and you will see 
how this works later in the exercise. 

11. Click OK to close the Distribution Region Specification dialog. 
12. You see the distributed plum trees. Note how the trees align up with each other.  
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13. Select the distribution region again and open its specification dialog. 
14. In the Object Spacing section select the radio button for Alternate Grid. 
15. Click OK to close the dialog. 

 

16. Select the distribution region and open its specification dialog. In the Display Options section, 
uncheck the checkbox for Show Region. Click OK to close the dialog. This is a handy option to use if 
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you do not want to explode the region and just want to see the trees. This way you retain the ability 
to reshape the region.   

17. Select Build ►Distributed Objects ► Spline Distribution Path. Start at the deck step and draw a 
spline to the trees. You can adjust the shape and direction of the spline before or after you add the 
distributed objects. 

18. Select the spline and open its specification dialog. You should be on the Distributed Object panel. 
19. Click the Select button to display the Select Library Object dialog. Select Exteriors ► Landscaping► 

Rocks & Stones ►Rock 1.  
20. Click OK to close the Select Library Object dialog. 
21. Click the Edit button to display the Fixture Specification dialog. Change the Height to 2”. Change the 

Width and Depth to 10”. 
22. Click OK to close the Fixture Specification dialog. 
23. Change the Distance Between Object Centers to 14”. Note that you could also select the option, 

Number of Evenly Distributed Objects. You can then specify how many objects there should be. 
24. Click OK to close the dialog. 

25. With the distribution path still selected, click the Copy and Paste in Place edit button. This will 
place a copy right on top of the original distribution path. 

26. Click the  Open Objects edit button to display the Distribution Path Specification dialog. 
27. Click the Select button to display the Select Library Objects dialog.  
28. Select Architectural ► Lighting ► Outdoor Lighting ► Path Lights ►Path Light (wide brim). 
29. Click OK to close the Select Library Objects dialog.  
30. Set the Distance Between Object Centers to 48”. In the Object Positioning section, check the 

checkbox for Alternate Sides. This will stagger the lights every 48” to either side of the path. Change 
the value for the Side Offset to 48”. To avoid putting a light to close to the deck, change the value 
for the Start Offset to 8’. 

31. Click OK to close the Distribution Path Specification dialog.  

32. Take a Perspective Full Overview to view your work in 3D perspective. 

 

33. Close the drawing without saving. 
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CAN YOU DO IT? 
 

 

Draw Fig. 1.7. Draw the object (Block) shown, then make it a block and add it to the User Catalog of your 

library. Then use the  Polyline Distribution Region tool. Grid squares are 1 foot. 

 

PROBLEM SEVEN 
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Step By Step Tutorial 
This chapter will pressent the edit tools for aligning and 
distributing objects that were introduced with Chief 
Architect X3.  

 

 

 

The drawing, D3.plan, is used in the following exercise on aligning and distributing a 
group of objects, and can be found in the X9 Expert Drawings Before folder. If you have an older 
version of Chief Architect (X3 or newer) use the D3.plan from the Older CA Drawings Before 
folder. Both of these folders are in the Advanced CAD folder. 

STEPS: Aligning and Distributing a Group of Objects 

1. Open the D3.plan. The drawing shows a one story house with a basement foundation and an 
attached garage. A deck is attached to the rear of the house. Off to the right of the deck four slabs in 
various sizes have been drawn. 

2. Using the select objects mode, drag to select all four of the slabs. Note the two edit tools that are 

available on the right end of the Edit toolbar.  They are the  Align/Distribute Objects edit tool 

and the  Align/Distribute Along Line edit tool. 

 

3. Click the  Align/Distribute Objects edit tool button. The Align/Distribute Objects dialog 
displays.  There are two basic options presented by this dialog. You can decide how you want the 

CHAPTER 4 
Aligning and 
Distributing a Group 
of Objects 
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selected objects to change vertically and how you want them to change horizontally. By default, 
Don’t Move Vertically and Don’t Move Horizontally are selected. 

 

 

4. In both the Move Objects Vertically to section and the Move Objects Horizontally to section, select 
Centers.  

5. Click OK to close the Align/Distribute Objects dialog. You will see the selected slabs move to a 
center position. Their centers are aligned with each other. 

 

6. Click the  Undo tool button. 

7. Select the four slabs again and click the  Align/Distribute Objects edit tool button to display the 
Align/Distribute Objects dialog. Note that Chief Architect remembers the previous setting. If you do 
not want to, for example, make a vertical change you will have to select Don’t Move Vertically.  

8. In the Move Objects Vertically to section, select Don’t Move Vertically. In the Move Objects 
Horizontally to section, select Right Edges. Choosing this option will move all of the slabs so that 
their right edges will align with each other. If you had chosen Left Edges, then all of the slabs will 
move so that their left edges align. 

9. Click OK to close the Align/Distribute Objects dialog. You will see the slabs move so that their right 
edges are aligned with each other. Notice that they are not evenly distributed. 
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10. With the four slabs still selected, click the  Align/Distribute Objects edit tool button to display 
the Align/Distribute Objects dialog. This time in the Move Objects Vertically to section, select 
Space Evenly. This will make the space between each of the slabs the same. 

11. Click OK to close the Align/Distribute Objects dialog. Now the spacing between each of the slabs is 
equal. 

 

12. With the four slabs still selected, click the  Align/Distribute Objects edit tool button to display 
the Align/Distribute Objects dialog. In the Move Objects Vertically to section, select Distribute 
Centers Evenly. 

13. Click OK to close the Align/Distribute Objects dialog. Now the distances between the centers of the 
slabs are equal. 

 

These alignment and distribution tools work for most of the Chief Architect objects. They also work 
for objects that are dissimilar.  

14. Place a base cabinet below the 4 slabs. Select the base cabinet and the 4 slabs. 
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15. Click the  Align/Distribute Objects edit tool button to display the Align/Distribute Objects 
dialog. In the Move Objects Vertically to section, select Don’t Move Vertically. In the Move Objects 
Horizontally to section, select Left Edges. 

16. Click OK to close the Align/Distribute Objects dialog. You will see the slabs and the cabinet move so 
that their left edges are aligned with each other. 

 

 

17. Start the   Draw Line tool (the hot key for drawing lines is the W key) and drag to draw an 
angled line to the right of the slabs and the cabinet. We are going to use this line as a reference line 

to demonstrate the  Align/Distribute Along Line edit tool. 

 

18. Select the four slabs and the cabinet and click the  Align/Distribute Along Line edit tool button. 
Move the cursor to the line. Note that you will get the bold feedback axis line that shows the line 
you are choosing to align the objects with. So if you have a bunch of lines in the area it is easy to use 
the feedback axis to pick the line you want. This feedback axis was introduced in Chief Architect X3. 
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19. Click on the line once you see the feedback axis appear. The Align to Line dialog displays. 

 

 

20. In the Alignment section, leave None selected (it is selected by default).  In the Distribution section, 
select Space Evenly. This will make the distances between the object edges in relation to the line 
consistent. Leave Distribute To Endpoints selected. 

21. Click OK to close the Align to Line dialog. Note that the objects did not align onto the line but that 
they did align in relation to the line. They all moved so that their edges in relation to the line are 
consistent.  Let’s look at another example. 
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22. With the four slabs and the cabinet still selected, click the  Align/Distribute Along Line edit 
tool. Select the line to display the Align to Line dialog. 

23. Select Distribute Centers Evenly and Distribute Between Endpoints. Again leave None selected in 
the Alignment section so that there is no alignment to the line itself. 

24. Click OK to close the Align to Line dialog. Now the objects have distributed between the end points 
of the line so that the centers of the objects perpendicularly intersect the line evenly (see the 
following illustration). 

 

25. With the four slabs and cabinet selected, click the  Align/Distribute Along Line edit tool. Select 
the line to display the Align to Line dialog. 

26. In the Alignment section, select Centers. This will align the centers onto the line. Leave Distributed 
Centers Evenly and Distributed Between Endpoints selected. 

27. Click OK to close the Align to Line dialog. You will see the exact same distribution only this time the 
centers of the objects are aligned on the line. 
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28. With the four slabs and cabinet selected, click the  Align/Distribute Along Line edit tool. Select 
the line to display the Align to Line dialog. This time select the Distribute To Endpoints option. 
Leave the options Centers and Distribute Centers Evenly selected. So now the objects will align their 
centers onto the line and the centers will be distributed evenly apart and the centers will be 
distributed from the endpoints of the line. 

29. Click OK to close the Align to Line dialog and you see the result. 

 

30. Delete the line. 
31. Select the four slabs and the cabinet. 

32. Click the  Align/Distribute Along Line edit tool. Move the cursor to the right exterior wall of the 
residence. When the feedback axis line appears along the wall, click the mouse button. The Align to 
Line dialog displays. 

33. In the Alignment section, select Closest Edges. Leave Distribute Centers Evenly selected and select 
Distribute Between Endpoints. 

34. Click OK to close the Align to Line dialog. The objects move so that their left edges are aligned to the 
wall and their centers are spaced evenly apart, including the distances from the end of the wall to 
the center of the nearest object. All of these distances are the same. 
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You can apply these new align and distribute tools to other objects, such as windows and doors. 

35. Select the two windows to the right of the front left corner of the house. Also select the front entry 

door. Select the  Align/Distribute Along Line edit tool. Move the cursor to the front exterior 
wall and when the feedback axis line appears along the wall, click the mouse button to display the 
Align to Line dialog.  

36. Select Centers and leave the Distribute Centers Evenly and Distribute Between Endpoints options 
selected. 

37. Click OK to close the Align to Line dialog. The windows and the door are now distributed along the 
wall evenly. 

You will find that the alignment and distribution tools provide feedback as to where they are going to 
align and will work with most Chief Architect objects. They will also allow you to align and distribute 
dissimilar objects. 

  

CAN YOU DO IT? 
34.  

Use the D3.plan drawing from the DVD. If you are using an older version of Chief Architect, and are using 
the D3.plan file from the Older CA Drawings Before folder, you will need to randomly place 8 utility 

PROBLEM EIGHT 
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shelfs in the garage (from the Chief Architect Core Catalogs select Interiors ⇒ Furniture ⇒ Storage 
Furniture ⇒ Shelving ⇒ Utility Racks ⇒ Utility Shelf tall). (See the following illustration).  

 

Arrange the storage components in the garage so that they are evenly distributed on the west and north 
walls of the garage. Your drawing should look familiar to Fig. 1.8. 
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Step By Step Tutorial 
This chapter will review the basic ways to break polylines. 

 

 

 

The drawing, D4.plan, is used in the following exercise on breaking polylines, and 
can be found in the X9 Expert Drawings Before folder. If you have an older version of Chief 
Architect (X3 or newer) use the D4.plan from the Older CA Drawings Before folder. Both of these 
folders are in the Advanced CAD folder. 

 

STEPS: Breaking Polylines 

1. Open the D4.plan. The drawing shows a two story house with a basement foundation. A deck is 
attached to the rear of the house. The terrain features should be turned on.   

2. Select the  Rectangular Polyline tool (the hot key is Shift + P) and draw a 2-dimensional polyline 
to the left side of the model. 

 

3. Select the polyline.  Move the cursor over the  Break Line edit button. Notice the pop-up tip 
that appears. The number 3 in the parentheses tells you that the 3 key on your keyboard is the 
keyboard shortcut for the Break Line command. 

CHAPTER 5 
Polylines-Breaking 
Polylines 
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4. Press 3 on your keyboard. Click on the front edge of the polyline near the front right corner. You will 
get a new corner diamond shaped edit handle. You also get a new edge square shaped edit handle.  

 

5. Move the edge edit handle that is to the right of the new corner edit handle downward. A 90 degree 
corner is formed and two new edges are created. 

 

6. Drag the edit handle back and snap it back in place using the On Object snap so that it is aligned with 
the original front edge.  
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7. Drag the new corner edit handle downward. You see the kind of effect you get. 

 

8. Click the  Undo tool button. 
9. Select the front edge and notice that the new corner edit handle is still in place.  
10. Drag the new corner to the left and release it when the Midpoint (if you don’t see a Midpoint snap, 

turn off the Intersections snap by pressing the 0 key)snap displays.  
11. Drag the edge edit handle that is to the right of the new corner edit handle downward again. 

 

Once you have created a break you have the editing ability that you have just seen. 
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12. Align up the two front edges as you did earlier. 
13. Move the new corner edit handle and snap it to the front left corner of the polyline. The new corner 

is removed and you see only one edge edit handle on the front edge of the polyline. This is an easy 
way to remove a corner edit handle.  

14. Click the  Break Line edit button and then click the  Complete Break edit tool (if you are 

using an older version of Chief Architect, double click the  Break Line edit button or press the 3 
key in rapid succession). Click on the front edge of the polyline. This time a square edge edit handle 
is created where you clicked. Drag the edge edit handle that is to the right of where you clicked 
downward. Notice what happens. The polyline is now severed. If you are using an older version of 
CA you will see something similar to the following illustration on the left. Newer versions of CA will 
see something similar to the illustration on the right (the diamond shaped edit handles that were 
formed by the break are same line type edit handles).  

                                       

15. Move the severed front edge back up and snap it back where it was using the On Object snap. The 
polyline becomes whole again. You will know this by the solid gray fill. You have repaired the 
severed break. 
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The Complete Break command will not work for many of the special CAD polylines in Chief Architect 
that are meant to be closed. These special polylines include slabs, countertops, terrain perimeters, etc. 

16. Select the terrain perimeter. Click the  Break Line edit buttons The  Complete Break edit 
tool is not made available as this special CAD polyline cannot be broken. If you are using an older 

version of Chief Architect, double click the  Break Line edit button or press the 3 key in rapid 
succession. Click on the left perimeter edge. Notice that instead of a square edge edit handle being 
created as before, a diamond corner edit handle is created. You also have the square edge edit 
handles on each side of it. Drag one of the square edge edit handles to the left to see what happens. 
The terrain perimeter cannot be severed. A roof plane cannot be severed either, as shown next. 

17. Select the front roof plane for the model. Click the  Break Line edit buttons The  Complete 
Break edit tool is not made available as this special CAD polyline cannot be broken. If you are using 

an older version of Chief Architect, double click the  Break Line edit button or press the 3 key in 
rapid succession. Click on the left edge of the roof plane. The same thing happens to the roof plane 
that happened to the terrain perimeter. Again, you cannot sever this kind of polyline. 

There are some special polylines in Chief Architect that can be severed. 

18. Draw another polyline below the first one that you drew. This polyline, as you have seen, can be 
severed.  

19. Select the polyline and click the  Convert Polyline edit button. You will get the Convert Polyline 
dialog. Select Molding Polyline. This is a special case example of a special polyline that can be 
severed using the Complete Break command. 

20. Click OK to close the Convert Polyline dialog. The Molding Polyline Specification dialog displays. 
Click OK to close it. 

21. Click the  Break Line edit button and then click the  Complete Break edit tool (if you are 

using an older version of Chief Architect, double click the  Break Line edit button or press the 3 
key in rapid succession). Click on the bottom edge of the molding polyline. A square edge edit 
handle is created where you clicked. This tells you that this is a break. Notice also that the molding 
polyline is no longer shaded. Drag the edge edit handle that is to the right of the break point 
downward to see the break more clearly. In regards to molding polylines, you may want to do this to 
remove molding from a certain area. The next step gives you a better idea of how this can work. 
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22. Select the molding polyline. Click the  Break Line edit button and then click the  Complete 

Break edit tool (if you are using an older version of Chief Architect, double click the  Break Line 
edit button or press the 3 key in rapid succession). Click on the front edge a distance to the right of 
the front left corner of the polyline. Drag the edge edit handle to the left of this new break down 
and align it with the other front edge you created. Notice what remains. You can remove this piece 
of the molding. So you can remove molding from certain areas quite handily by using this tool. 

 

Another special polyline that the Complete Break command will sever is an elevation line or an 
elevation region. 

23. Zoom into the area to the left of the deck where you see a rectangular shaped polyline. Double-click 
this polyline. You should get the Elevation Region Specification dialog. If so, you have selected the 
correct polyline. Close the dialog. 
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24. Click the  Break Line edit button and then click the  Complete Break edit tool (if you are 

using an older version of Chief Architect, double click the  Break Line edit button or press the 3 
key in rapid succession). Click on the front edge of the elevation region to create a break. Drag one 
of the edge edit handles to either side of the break to see clearly that the region has been severed. 

The nice thing about the  Break Line edit tool is that it has many functions and it works 
differently with different types of polylines depending on whether they can be broken or not. You can 
always just try it to find out. 

CAN YOU DO IT? 
 

Draw Fig. 1.9 using only the  Break Line edit tool. Begin by using the  Rectangular Polyline 
tool to make a square 2’ x 2’.   

 

 

 

 

PROBLEM NINE 
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Draw Fig. 1.10 Begin by using the  Rectangular Polyline tool to make a 17” x 11” polyline.   

 

PROBLEM NINE 
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Step By Step Tutorial 
This chapter will discuss how polylines can be merged 
together to form a resultant polyline based on the union or 
intersection of two or more polylines. 
 

 
The illustration shows plain polylines. You will learn that they can be merged. You can also merge 
other polylines as long as they are the same type. They don’t necessarily have to have the same 
thickness. For example, you can merge slabs, polyline solids, countertops, lot perimeters, etc. There is 
also the situation where one of the polylines to be merged could be a special type, like for instance, a 
countertop and the other polyline could be a plain polyline. The resultant would take on the 
characteristics of the special polyline. 

The drawing, D5.plan, is used in the following exercise on merging polylines, and 
can be found in the X9 Expert Drawings Before folder. If you have an older version of Chief 
Architect (X3 or newer) use the D5.plan from the Older CA Drawings Before folder. Both of these 
folders are in the Advanced CAD folder. 

 

STEPS: Merging Polylines 

1. Open the D5.plan. The top half of the drawing shows two identical groups of plain polylines that are 
overlapping each other. Let’s first work with the group on the left. Like the group on the right, it has 
three polylines that overlap. If we form a union, the resultant polyline will have the shape of the 
combined polylines, as you will see. 

2. Select all three of the polylines in the group on the left. 

3. Click the Polyline Union edit tool button. A dialog will display, asking if you want to delete the 
original polylines. Click the Delete Original button. Press the Esc key to see the result. 

CHAPTER 6 
Polylines-Merging 
Polylines that Overlap 
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If we form an intersection the resultant polyline will take the shape of the area overlapped by all of the 
polylines combined.  

4. Select all three of the polylines in the group on the right. 

5. Click the  Polyline Intersection edit tool button. In the dialog that displays, click the Delete 
Original button again. You see the result of the intersection. 

 

You can merge polylines to form a resultant polyline that will either be the result of a union or an 
intersection. 

 

CAN YOU DO IT? 
 

 

Using the solid models in the lower half of the D5.plan from the DVD, create the solids shown in Fig. 

1.11., using the Polyline Union edit tool and the  Polyline Intersection edit tool. If you are 
using the older D5.plan, you will need to create the solid models by combining a 3D box with a 3D 

cylinder from the  Primitive tools drop-down menu.  

 

 

 

PROBLEM TEN 
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Try solving this problem by working in 3D space (click the  Perspective Overview button, for 

example). Once in 3D space, use the  Glass House rendering technique to get a better picture of 
what is happening. 

 

PROBLEM ELEVEN 
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Step By Step Tutorial 
This chapter will review how to subtract one 
overlapping polyline from another to create a resultant 
polyline with a new shape. 

 

The drawing, D6.plan, is used in the following exercise on subtracting polylines, and 
can be found in the X9 Expert Drawings Before folder. If you have an older version of Chief 
Architect (X3 or newer) use the D6.plan from the Older CA Drawings Before folder. Both of these 
folders are in the Advanced CAD folder. 

 

STEPS: Subtracting Polylines 

1. Open the D6.plan. The drawing shows a model that is partially enclosed by invisible walls. 

2. Select the  Rectangular Polyline tool and draw a rectangular polyline in an open area inside the 
model. Make it about 6’ x 4’ in size. Draw another one that overlaps the lower right corner of the 
first one. Press the space bar. 

 

3. Select the first polyline. 

4. Click the  Polyline Subtraction edit tool button. Select the second polyline, which is the one we 
want to subtract from the first polyline. This will remove from the first polyline the area where the 
two polylines overlap. You will be given two options. You can either retain the original polylines or 
delete them. Click the Retain button. 

CHAPTER 7 
Polylines-Subtracting 
Polylines that Overlap 
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5. Select the first polyline and drag it away to the left. You can see how it has become a new polyline 
with a new shape based on the subtraction. 

 

6. Select all three polylines and delete them. 

7. Take a camera   Perspective Floor Overview. You can also subtract special polylines from each 
other as you will see next. 

8. Select the  Slab tool (other special polylines could be used as well, such as polyline solids). Drag 
to draw a slab in an open area inside the model. Then drag to draw a second slab that overlaps the 
front right corner of the first slab. 

 

9. Select the first slab. 

10. Click the  Polyline Subtraction edit tool button. Select the second slab. This time, click the 
Delete Original button in the dialog that displays. Only the resultant polyline remains.  
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You can also subtract primitive solids from each other. 

11. Select the  Cylinder tool. In an open area inside the model, drag to draw the base of the 
cylinder, then release the mouse button and drag up to extrude the cylinder. Click to finish drawing 
the cylinder. 

 

12. Click on the top of the cylinder to select it. 

13. Click the  Copy/Paste edit button. Drag the original to make a drag copy. Move the copy so that 
if overlaps the original. 
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14. Select the copy, drag the top edit handle down and the bottom edit handle up to reshape the 
cylinder to resemble the following illustration. 

 

15. Press the Esc key. 

Now we will do some subtraction. 

16. We want to subtract from the first cylinder that you drew, so select it. 

17. Click the  Polyline Subtraction edit tool button. Select the second cylinder. You see the result. 

 

As you have learned, you can subtract similar polylines from each other, and you can also subtract 
primitive solids from each other. Let’s look at another example, by working with the cabinets in the 
model. 

18. Close the 3D view.  
19. Zoom in closer to the cabinets. 

20. From the  Cabinet Tools, select the  Custom Countertop tool button.   
21. Move the cursor to the rear left corner of the corner cabinet. Click and drag the countertop so that 

it includes all of the cabinets, using the extension snaps. Release the mouse button when finished. 
The custom countertop will assume the material of the countertops of the cabinets below it and it 

will also assume the proper elevation. To see this take a  Perspective Floor Overview. 
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22. Close the 3D view. 

23. Select the  Rectangular Polyline tool and draw a rectangular polyline so that it resembles the 
following illustration. 

 

You are going to be able to use the plain polyline to alter the shape of the custom countertop polyline, 

by using the  Polyline Subtraction tool. 

24. Reshape the plain polyline to resemble the following illustration, by dragging its upper left corner 
down to the lower left corner. 

 

25. Select the diagonal edge. 

26. Click the  Change Line/Arc edit button. Adjust the curvature by dragging the small triangular 
edit button towards the cabinets. 



 

 
54 

 

 

27. Move the plain polyline so that there is a somewhat equal distance between the curvature and each 
end of the cabinets. 

 

28. Press the Esc key. 

29. Select the custom countertop, which is what we want to subtract from. Click the  Polyline 
Subtraction edit tool button. Select the plain polyline. Click the Delete Original button in the dialog 
that displays.  

 

30. Take a  Perspective Floor Overview, to see what you have been able to do. 
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A plain polyline can be subtracted from another to create a resultant polyline, whose shape is based on 
the subtraction. You can also subtract special polylines from each other, as well as primitive solids 
from each other. And, as just shown, you can subtract a plain polyline from a special polyline to create 
a new special polyline with a new shape. 

 

CAN YOU DO IT? 
 

 

Use the  Box tool and the  Polyline Subtraction edit tool to create the object shown in Fig. 
1.12A and Fig. 1.12B. 

 

PROBLEM TWELVE 
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Create the solid model shown in Fig. 1.13. 

 

 

PROBLEM THIRTEEN 
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Create the solid model with the beveled edge shown in Fig. 1.14. Use the   Cylinder tool to draw a 

cylinder. Overlay it with a cone using the  Cone tool.  You want the cone to have the same diameter 
as the cylinder. Varying the height of the cone determines the steepness of the beveled edge. Subtract 
the cone from the cylinder (you may need to lower the cone so that it is 1/16th inch lower than the 
cylinder so that it can be easily selected for subtraction).  Create another cylinder with the same 

diameter as the first cylinder.  Overlay it on the cylinder/cone object. Use the   
Transform/Replicate Object edit tool button to move the original cylinder/cone so that it intersects the 
top of the new cylinder. In the illustration the overlap of the two objects is 2”. Subtract the original 
cylinder/cone from the new cylinder to create the beveled edge. 

 

PROBLEM FOURTEEN 
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Step By Step Tutorial 
This chapter will show you how to use the Chief 
Architect’s line style editing tool to design your own line 
styles. This tool was first introduced in Chief Architect 
X2. 

 

The drawing, D7.plan, is used in the following exercise on using the line style editor, 
and can be found in the X9 Expert Drawings Before folder. If you have an older version of Chief 
Architect (X3 or newer) use the D7.plan from the Older CA Drawings Before folder. Both of these 
folders are in the Advanced CAD folder. 

 

STEPS: Using the Line Style Editor 

1. Open the D7.plan.  
2. Draw a horizontal line about 40’ long in an open area to the rear of the model. 
3. Double-click the line to display its specification dialog. Go to the Line Style panel.  In the Line 

Options section click on the Style drop-down arrow to see the list of line styles. You can choose, 
quickly, from a number of line styles here. 

 

CHAPTER 8 
Using the Line Style 
Editor 
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4. In the Line Options section, click the Library button. The Select Library Object dialog displays. From 
Chief Architect Core Catalogs, expand Line Styles. You will see that you have a number of categories 
of line styles to choose from. 

 

5. Select Plumbing Line Styles ► Cold Water Supply (medium). 
6. Click OK to close the Select Library Object dialog. 
7. Click OK to close the Line Specification dialog. You see the line style that was chosen from the 

library. 

 

You can also go directly to the library and choose the line style that you are going to draw with. 

8. Go to the Library. From Chief Architect Core Catalogs, select  Line Styles ► Plumbing Line Styles ► 
Waste Water (large). 

9. Drag to draw a horizontal line in an open area in front of the model. The line will be of the line style 
that you chose from the library (if you restart the Line command you will get a normal solid line). 
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You can further modify any of the lines you have drawn by using Chief Architect’s line style editor, as 
well as create new line styles. 

10. In the Library, from Chief Architect Core Catalogs, select  Line Styles ► Plumbing Line Styles ► 
Cold Water Supply (medium). Right-click and select copy (note that there is no Open selection 
available to edit this locked library item). Paste the copy in the User Catalog (right-click on User 
Catalog and click Paste). Right-click on this now unlocked library item and click Open Object for 
editing. The Line Style Specification dialog displays. 

 

11. In the Line Style Name edit box, change the name to City Water Supply (just as an example).  
12. Notice the box that is highlighted in red in the graphic display window. Notice that in the 

components selection window Dash is highlighted.  Click on Text to highlight it. The red highlighted 
box jumps to the first text entry. Click on Dash and the box jumps to the next dash entry. The 
vertical dashed line indicates the end of the pattern, which will now be repeated.  
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You can insert new components by clicking on a component button. The components are Dash, Dot, 
or Text. You can adjust the position of the components using the up or down arrow buttons to the 
right of the component window. You can insert a new component before or after the one that is 
selected by choosing between the Insert Before or Insert After options. 

13. Select the Insert After radio button if it is not already selected.  
14. Click the Text button. You see the word TEXT highlighted by the red square. 

 

15. Find the Text edit box on the right side of the dialog. This is where you can change the name of the 
text that you want to insert. Change the name to City. 

16. You want your new text to be the same height as the other text in the line. To see what that height 
is just click on the C/W text. The height will be listed in the Text Height scrollable edit box. 3/32” 
should be listed.  Click on your text and change its height to 3/32”.  

17. Notice that with your text selected that the value listed in the Spacing scrollable edit box is 1/8”. 
Click the down arrow to decrease this value.  Click the up arrow to increase the value. As you do this 
you can see in the graphic window the changes. It is the space to the right of the text that is 
adjusting. Change the value to 1/16”.  

We want this same value in the spacing before the text as well. 

18. Select the dash that is before the City text by either selecting Dash in the components selection 
window or by clicking on the dash that is before the text in the large graphic window. 

19. Change the value in the Spacing scrollable edit box to 1/16”. You can inspect the result in the large 
graphic window and make changes as appropriate until you feel that you have it right. 
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In the same manner that you added the text you can add a dot or a dash. By working with the 
different parameters that are available you can get things to look like you want them.   

20. Click OK to close the dialog and to save your changes. You have now modified the library object that 
you put in your User Catalog. Select it and drag a horizontal line in an open area below where you 
drew the last line. 

 

In addition to editing the line styles that are found in your library to create new ones, you can also 
import line styles from other locations. It will then be added your User Catalog in the Library. 

21. Select File ►Import ► Import Line Style Definitions. The Import Line Styles dialog displays. From 
here you can browse to where line styles are kept, such as the line styles found in a previous version 
of Chief Architect, for example, Chief Architect X2. Chief Architect X3 uses the extension .lin for lines 
styles. To find the line styles in previous versions, change Files of type to All Files. Go to the 
appropriate Chief Architect folder and select it. Look for the file legacyLineStyles.dat. Select it and 
click Open. A dialog will display telling you that the line styles have been successfully added to your 
User Catalog in your library. Click OK. You will see a new folder called legacyLineStyles added to 
your My Library folder. You can change the name and place it somewhere else in your library if you 
wish. You can now choose any of these line styles and draw lines in your plan. 

The ability to edit and import line styles gives you a great deal of flexibility. 

 

CAN YOU DO IT? 
 

 

Using the D7.plan, draw the utility layout as shown in Fig. 1.15. 

 

PROBLEM FIFTEEN 
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Step By Step Tutorial 
Beginning with Chief Architect X3, line style and layer 
information about Chief Architect objects now transfers 
with those objects from one X3 plan to another in ways 
that are both intuitive and easy to understand. Let’s first 
look at how layers transfer. 

 

 

 

STEPS: Transferring Layer Information and Line Style Attributes 

1. If you have Chief Architect running select File ► New Plan. If the program is not running, then go 
ahead and start Chief Architect and select New Plan from the Welcome to Chief Architect splash 
screen. Zoom into the drawing close enough to see the snap grid.  

2. Draw a simple horizontal CAD line and open its specification dialog. 
3. Go to the Line Style panel. By default, CAD, Default, should be listed for the Layer in the Line 

Options section. We will create a new layer. 
4. Click the Define button. The Layer Display Options dialog displays. 
5. Click the New button. The New Layer Name dialog displays. 
6. Label the new layer, “A” (without the quotes).  Put a space in front of the letter. Click OK. Placing a 

space in front sorts the new layer to the top of the list. 
7. Click OK to close the Layer Display Options dialog. “A” is now the new layer for the line. Click OK to 

close the Line Specification dialog. 

8. Label the line “A” by clicking the  Text Tools button, and then clicking to the left of the line. 
Type “A” when the Rich Text Specification dialog (you may get the Text Specification dialog if you 
have not checked Create Rich Text in the Leader Lines section of the Text subcategory of the 
Appearance category of the Preferences dialog) displays. Click OK. 

 

9. Draw a second line below the first line. Following the same procedure for line A, put this line on a 
new layer “B” and label the line “B”. Be sure to place a space before the layer name. 

CHAPTER 9 
Transferring Line Style 
and Layer Information 
between Plans 
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You created layer A before you created layer B. In older versions of Chief Architect, this layer creation 
order affected object layer assignments when objects were transferred between plans. Sometimes you 
would find objects on a layer that you did not expect to. Beginning with Chief Architect X3 this is no 
longer the case. Chief Architect now transfers objects between plans based solely on the name of the 
layer. This makes transferring layers much easier to follow. Let’s look at an example of this. 

10.  Open a new plan (do not close the plan you now have open). 

11. Click the  Display Options tool button to display the Layer Display Options dialog (for those 
with a newer version of Chief Architect you can use the Active Layer Display Options palette). Note 
that you do not see the new layers, A or B listed.  

12. Click the New button and type B (place a space in front) in the New Layer Name dialog. Click OK. 
Click the New button again and type A (place a space in front). Click OK. You have reversed the 
order in this plan and the layer B was created before the layer A. For users of older versions of CA, 
click OK to close the Layer Display Options dialog. 

13. Tile the two windows vertically. Make the plan that has the lines the active window (by clicking on 
its title bar or clicking in the drawing area) and select both of the lines, including the text. 

14. Click the  Copy/Paste edit button. Transfer the two lines into the new plan by first making the 
new plan the active plan and then selecting Edit ► Paste ► Paste. Click in the plan’s drawing area 
to transfer a copy of the two lines. Press Esc. 

15. Select the top line and open its specification dialog. Go to the Line Style panel. Note that the layer 
listed in the Line Options section is layer A.  

16. Check to see which layer the lower line is on. It should be on layer B. Close the dialog. 

Chief Architect transferred the layer information for the lines based solely on the layer name. In the 
exercise you have been doing, it looked in the new plan for a layer named A. Upon finding the layer it 
placed the object (the line) on that layer. If it did not find a layer named A, it would have created a 
layer with the layer name A, or whatever the name of the source layer was.  

This preservation and transfer of layer information also holds true when objects are grouped into CAD 
blocks. 

17. Close the new plan without saving. 
18. Open a new plan. Move it into place beside the original plan that you drew the lines in. 
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19. To form a CAD block, group select the two lines in the original plan (be sure to press the Esc key first 

or you will copy the two lines again), and then click the  Make CAD Block edit button. 

20. Add the block you just made to the library by clicking the  Add to Library edit button. The layer 
information is preserved and transferred by name whether you add it to the Library and store it 
there for a while and then move it to another plan, or whether you copy it directly to another plan 
(by simply pasting it in the other plan). 

21. Make the new plan the active plan. Select the new block from the Library and click in the new plan 
to paste the block. Press Esc. 

22. Explode the block in the new plan by clicking the  Explode CAD Block edit button. You will find 
that this new plan now has the layers A and B and that the lines have the layers that they were 
originally assigned to. 

Line style properties are also transferred in this straight forward manner. It is the line attributes that 
are matched. 

If you open a plan that has line styles that are not listed in Chief Architect’s library of line styles, then 
Chief Architect will bring those line styles in as they exist. But if you bring in a plan that has a line 
style whose attributes matches those of a line style within Chief Architect’s library of line styles, then 
Chief Architect will simply use the attributes of the line style it has already. So for example, let’s see 
what will happen if you open a plan that was created in a previous version of Chief Architect that has 
line styles that do not currently exist in the current version of Chief Architect. 

23. Close the new plan without saving.  
24. Open the X2 Line Styles.plan from the DVD in the X6 Expert Drawings Before folder (or if you are 

using an older version of CA, select the file from the Older CA Drawings Before folder). You will see 
three different line styles displayed. 

 

The first one, the line indicating a gas line, does exist in the Chief Architect’s Line Style library, so the 
program will use the one it already has. The next two line styles do not have a match in the Chief 
Architect library. Since they did not exist, Chief Architect simply brought them in. They are not 
added to the library but they will save with this plan. 

In Chief Architect, layer and line style information assigned to objects transfers to other plans. Layers 
match by name and line styles match by attributes. This is true when you copy objects individually, or 
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group them into CAD blocks, and copy them directly between plans, or first place them in the library 
for storage and then move them to another plan. 

25. Close the drawings without saving. 

 

Step By Step Tutorial 
Chief Architect’s trim and extend edit tools are very 
powerful and they have broad application. Let’s look at 
some examples. You can easily cut and fill large arrays of 
joists, rafters, and CAD lines and other objects quite quickly 
with these two tools. 

The drawing, D8.plan, is used in the following exercise on using the trim and extend 
commands, and can be found in the X9 Expert Drawings Before folder. If you have an older 
version of Chief Architect (X3 or newer) use the D8.plan from the Older CA Drawings Before 
folder. Both of these folders are in the Advanced CAD folder.  

STEPS: Using the Trim and Extend Commands 

1. Open the D8.plan. This drawing shows floor joists on a foundation plan. 
2. Looking at the following illustration draw a polyline (a series of lines) across the foundation. 

 

CHAPTER 10 
Using the Trim and 
Extend Commands 
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3. Select the polyline. We will make this the trim boundary. Click the  Trim Object(s) edit tool 
button. It now becomes the trim boundary. 

4. Move the cursor to the first joist to the right of the left foundation wall. Since we want to trim that 
part of the joist that is above the polyline, click on the joist above the polyline. The joist is trimmed 

to the polyline. The polyline is still selected as the trim line. Click the  Trim Object(s) edit tool 
button once again. This time click on the joist adjacent and to the right of the first joist you trimmed 
but click below the polyline. Note that whatever side of the cutting line you click on deletes that part 
of the object. 

5. Click the   Undo button to restore the last joist you trimmed. 

6. Select the polyline again and click the  Trim Object(s) edit tool button. Click the  Sticky 

Mode edit button. Now you can trim more objects without having to click the  Trim Object(s) 
edit tool button again.  

7. Clicking above the polyline, trim back the next three joists adjacent to the joist that you had already 
trimmed. 

8. Click the  Select Fence edit button. Now you can select several objects at once to trim. The line 
that you drag will trim back all of the objects that it touches. 

9. Drag a line through the next 7 joists above the polyline. Release the mouse button and the joists are 
all trimmed back to the polyline. 

 

10. Since you are still in sticky mode you can continue to trim back objects. Trim the remaining joists by 
dragging a fence line through the joists above the polyline. All of the joists should now be trimmed 
back to the boundary line (the polyline). If there are any joists that did not trim back, click on them 
to trim them down to the polyline. As long as you remain in the sticky mode you can continue to 
trim. 
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11. Press the Esc key to exit the trim command. Press the Esc key again to deselect the polyline. 
12. Select the polyline and delete it. 
13. We want to extend the joists back to the rim joist on the rear foundation wall. Zoom into this area 

and select the rim joist. Make sure that the rim joist is selected (you should see Floor joist displayed 
in the Status bar). 

14. Click the  Extend Object(s) edit button. As with the trim command you can use the sticky mode 

to continue to extend objects. In this case, we will only need to extend once, so just click the  
Select Fence edit button.  Drag a line through all of the joists. Release the mouse button. All of the 
joists should extend to the rim joist. 

 

15. Press F6 to fill the window. 
16. Look at the following illustration and draw a rectangular polyline. The left side of the rectangular 

polyline should cross the joist as shown. Make the rectangle approximately 2’ x 4’. 
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17. Select the rectangular polyline. Click the  Trim Object(s) edit tool button.  Click the  Sticky 
Mode edit button. 

18. Move the cursor inside the rectangular polyline and click on the joist that crosses through near the 
middle of the polyline. Click on the joist on the left side of the polyline (click on the part that is inside 
the polyline). Click on any other joist that runs through the polyline. Press Esc. Notice that all of the 
joists have been trimmed back to the boundary. Delete the polyline. 

                                                       

19. Click the   Floor/Ceiling Framing Tools button to put yourself in the joist mode. Draw a joist 
as shown in the following illustration. 

 

20. Extend the joist you just drew to the joist on the right. 

 

21. Select the new joist and drag it up until it bumps against the cut joists. 
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22. With the new joist still selected, click the  Copy/Paste edit button. Click the  Sticky Mode 
edit button. 

23. Drag a copy of the joist down until it bumps against the cut joists.  

 

24. Now drag a copy up to bump against the upper horizontal joist you had placed. Drag another copy 
down to the lower horizontal joist you placed. Press Esc twice. Your drawing should now look similar 
to the following illustration. 

 

You have just incorporated the trim and extend tools into the editing of the floor framing. You 
will find that you will be able to use the trim and extend tools on many objects in a variety of 
ways. 
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CAN YOU DO IT? 
 
 

Draw the top illustration in Fig. 1.16 and then use the  Fillet Two Lines, and the  Trim Object(s) 
edit tools to obtain the following figure. (Assume the missing dimensions.) 

 

 

 
 

 
 
 
 

PROBLEM SIXTEEN 
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Draw the illustration in Fig. 1.17. You will find plenty of opportunities to practice using the  Trim 

Objects edit tool, the  Transform/Replicate edit tool, and the  Multiple Copy edit tool. Use 
only the 2-dimensional CAD tools to complete this drawing.  

 

 

 

PROBLEM SEVENTEEN 
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Step By Step Tutorial 
Revision clouds are polylines that are drawn using 
sequential arcs. They are usually used to call attention 
to parts of a drawing during the review stage. 

If you review or redline drawings, you can increase your 
productivity by using Chief Architect’s Revision Cloud 

feature to highlight your markups. The Revision Cloud tool creates a polyline of sequential arcs to 
form a cloud-shaped object. 

 In the following exercise you will learn how to add revision clouds to a drawing. 
 

The drawing, D9.plan, is used in the following exercise on drawing revision clouds, 
and can be found in the X9 Expert Drawings Before folder. If you have an older version of Chief 
Architect (X3 or newer) use the D9.plan from the Older CA Drawings Before folder. Both of these 
folders are in the Advanced CAD folder. 

 

STEPS: Drawing Revision Clouds 

1. Open the D9.plan. 

2. Click the  Default Settings tool button to display the Default Settings dialog. 
3. Expand the CAD category. 
4. Double-click Revision Cloud. The Revision Cloud Defaults dialog displays. In the Arc Length and 

Number section (on the Cloud panel) the radio button for Automatic Arc Lengths is checked by 
default. 
 

 
 

CHAPTER 11 
Drawing Revision 
Clouds 
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Selecting the radio button for Average Arc Length will allow you to adjust the length of the arcs that 
make up the revision cloud. Or you could select the radio button for Number of Arcs. 
 
You can set the Length Diversity, the Minimum Bulge, and the Maximum Bulge in the Size Variation 
section.  
 
The value for the Length Diversity is the maximum amount that a given arc’s length can deviate from 
the Average Arc Length (which you can set).  
 
The Minimum Bulge value is the smallest amount that a given arc can extend out from its center. For 
example, 0% allows arcs with a radius of 0, or essentially a flat line; 50% allows 180º arcs, or half 
circles; 100% only allows arcs of about 300º. 
 
The Maximum Bulge value is the largest amount that a given arc can extend out from its center. For 
example, 100% allows arcs of about 300º; 50% allows 180º arcs; 0% only allows arcs with a radius of 
0. 
 
5. Leave the radio button for Automatic Arc Lengths selected and go to the Line Style panel. We want 

to set up a different layer than the Default CAD Layer. 
6. Click the Define button. The Layer Display Options dialog displays.  
7. Click the New button and in the New Layer Name dialog, name the new layer, RC Mar05 (for 

Revision Cloud and today’s date). Click OK.  
8. Click OK to close the Layer Display Options dialog. 

 
You could use a different revision cloud layer with different display properties for future revisions. In 
this way you could easily determine when revisions took place. 
 
9. Click OK to close the Revision Cloud Defaults dialog, and click Done to close the Default Settings 

dialog. 
10. In the kitchen area, select the three cabinets that comprise the peninsula. 
 

 
 

11. Click the  Revision Cloud(s) Around Objects edit button. Note that the cabinets are still 
selected and that a revision cloud encloses them. Press the Esc key. 
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12. Select the revision cloud. You will see that you have a complex polyline. You can use the edit handles 

to adjust the shape of the polyline. The diamond edit handles represent the corners of the polyline 
and the square edit handles represent the edges. The entire cloud can be moved as well. 

 

 
 

13. Press Esc. Press F6 to fill the screen. Let’s say that we need another revision cloud for the rear right 
corner of the building where the exterior wall is angled. 

14. Select CAD ►Revision Cloud.  
15. Drag a revision cloud so that it encloses the corner (notice the graphic of a revision cloud following 

the cursor).  

 
 

16. Select the revision cloud. Like the first revision cloud you can edit its shape. Any of the revision cloud 
polylines can be converted back to a plain polyline. 

17. Click the  Convert to Plain Polyline edit button. Notice that you will get an entirely new set of 
edit handles that are related to the individual arcs that comprise the revision cloud. You can now 
adjust the curvature of each arc. Let’s place a call out for the revision cloud. 
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18. From the  Leader Line drop-down menu, click the   Callout button. Click near the right 
side of the revision cloud. The Callout Specification dialog displays. You should be on the Callout 
panel. Type the necessary information for the Callout Label. For this exercise, type 16. Type A6 in 
the Text Below Line text box. Select the radio button for Circle. 

19. Go to the Line Style panel and note the layer name for the callout. Text, Callouts, should be listed. 
This may be okay in some cases. But if you were planning on doing a lot of revision clouds you may 
want the callout to be on the same layer as the revision cloud. So you may want to change the layer 
to the layer you created earlier in the exercise for the revision cloud.  

20. Go to the Attributes panel and in the Cross Section Line section, check the checkbox for Display 
Cross Section Line.  

21. Go to the Text Style panel. This is where you can change the text font and properties. Click OK. 
22. Select the callout. Adjust the position of the cross section line so that it points to the revision cloud. 
 

 
 

There is a third way to create a revision cloud. 
 

23. From the  Circle drop-down menu, select  Circle About Center. Click on the center for 
the exterior man door going into the garage and then drag to draw a circle around the door opening.  

24. Select the circle and click the  Convert Polyline edit button. The Convert Polyline dialog 
displays. 
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25. Select the radio button for Revision Cloud. Click OK. The circle is converted to a revision cloud and 
you will see the Revision Cloud Specification dialog displayed. You can set revision cloud properties 
that are different than the default values if you wish 

26. Click OK to close the Revision Cloud Specification dialog. Press Esc. There is another way to get a 
revision cloud around a door. 

 

 
 

27. Select the main front entry door.  

28. Click the  Revision Cloud(s) Around Object edit button. This method is usually preferred over 
the one just shown because it is quicker and easier. 

29. Close the drawing without saving. 
 
You can quickly create a set of revision clouds with appropriate callouts and all on their own layer. 
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Step By Step Tutorial 

 
 

 

The drawing, D10.plan, is used in the following exercise on using the nudge tool, and 
can be found in the X9 Expert Drawings Before folder. If you have an older version of Chief 
Architect (X3 or newer) use the D10.plan from the Older CA Drawings Before folder. Both of these 
folders are in the Advanced CAD folder. 

 

STEPS: Using the Nudge Tool 

1. Open the D10.plan. This drawing shows a floor plan where a sofa has been placed in the living area. 
It needs to be positioned in the corner. 

 

2. Select the sofa. 

3. Use the  Pt to Pt Move edit tool to snap the outside corner of the sofa to the inside left front 
corner of the room. We don’t really want the sofa snug against the wall, so we need to nudge it 
over. 

CHAPTER 12 
Using the Nudge Tool 
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4. Double-click the  Select Object tool. The General Plan Defaults dialog displays. In the Snap 
Grid/Snap Units section, set the Snap Unit to 1”. Click OK.  

 

5. Select the sofa. Press the right arrow key on your keyboard. This will nudge the sofa to the right one 
inch. 

6. Press the up arrow key. This will nudge the sofa up one inch. 
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The Chief Architect nudge tool allows you to do the operation that you just completed. This tool was 
introduced in Chief Architect X2. The nudge distance is controlled by your snap setting distance. 

 

 

7. Change the snap unit to 10”.  Click OK. 
8. Select the sofa. Use the right arrow key to nudge the sofa over. Now you are moving the sofa in 

increments of 10”.  Use the other arrow keys to move the sofa around. 
9. Close the drawing without saving.

Note Your snap setting distance may be set to something different than one 
inch, in which case, the sofa would have moved to whatever the snap 
distance you had set. 

 



   

 
82 

 

Step By Step Tutorial 
When you create a CAD block in Chief Architect, an 
insertion point is automatically placed at its center. The 
insertion point can be precisely placed by snapping it 

into position. You could use the  Pt to Pt Move edit 
tool to snap to the insertion point and then snap it to 
some other object. A block can only have one insertion 

point and you can place that point wherever you wish. Since Chief Architect X3 you have the  
Select Insertion Point edit tool. 

 

The drawing, D11.plan, is used in the following exercise on placing insertion points in 
CAD blocks, and can be found in the X9 Expert Drawings Before folder. If you have an older 
version of Chief Architect (X4 or newer) use the D11.plan from the Older CA Drawings Before 
folder. Both folders are in the Advanced CAD folder. 

 

STEPS: Placing Insertion Points in CAD Blocks 

1. Open the D11.plan. If you have an older version of Chief Architect (X3 or newer), start a new plan. 
Select File ⇒ Import ⇒ Import Drawing (DWG, DXF). The Import Drawing Assistant displays. Click 
Next and click the Browse button. Find the D11.dwg file in the Older CA Drawings Before folder. Go 
through the Import Drawing Assistance. Make no changes. Click Finish. 

2. Select the lower left drawing showing a typical crawl space foundation. This is a CAD block that was 
taken from the Chief Architect library. Note the square edit handle in the center of the CAD block. 
When you place the cursor over this edit handle the cursor turns into a four -way arrow. This edit 
handle is the insertion point. 

CHAPTER 13 
Placing Insertion Points 
in CAD Blocks 
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3. Click the  Select Insertion Point edit tool. Click somewhere in the block. The insertion point is 
moved to where you clicked. You probably noticed that you could not snap the insertion point to 
another point in the block. Since this is the case it would be more precise to take another approach. 

 

 

4. With the block still selected, click the  Explode CAD Block edit button.  

Now all the block components are separate and you have snapping positions. We can place a 
temporary point where we want the snap to occur and where we want the insertion point to be. We 
are going to join the one block to the another block in the drawing. Anticipating where we want the 
blocks to join will determine where we want the insertion point to be. We want it to occur on the top 
outside corner of the sill plate. 

 

Note The insertion point will not snap to another point in the block. 
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5. Select the  Place Point tool. 
6. Snap a point to the top outside corner of the sill plate. 

 

The temporary points do not get included when you make a block, so they remain snappable.  

7. Reblock the block that you exploded by using a selection window and the  Make CAD Block edit 
tool. 

8. Click the  Select Insertion Point edit tool. Snap to the temporary point you placed.  

You can snap to this point because it is not a part of the CAD block. You can now precisely place the 
insertion point. Notice that when you move the cursor over the insertion point it becomes a 4-way 
arrow. You can now precisely place the two blocks together. 

9. Select the block above the block you just worked with and note where its insertion point is. It will be 
in the center where they are intially created. Explode this block. Press Esc. 

10. Place a temporary point at the lower left corner of the 2 x rim joist. Reform the block. 

 

11. Snap the insertion point to the temporary point that you just placed. 
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12. Delete the temporary points by clicking the  Delete Temporary Points tool button. 

13. Click the  Pt to Pt Move edit button. With the block still selected pick up its insertion point and 
snap it to the insertion point in the other block. Press the Esc key. The two blocks should now be 
joined precisely. 

 

Each of the two blocks have their own insertion points. If the two blocks are joined together to make a 
larger block, the new larger block will get its insertion point in its center. 

14. Group-select the two blocks using a selection window, and make one block using the  Make 
CAD Block edit tool. Notice that the insertion point is at the center of the new block. It will now be 
the only insertion point available. 

If  the block is exploded, the insertion points that were inserted in the nested blocks will become 
available once the nested blocks are no longer nested in the larger block. The insertion points will still 
be where you had last placed them. 

You have seen how each CAD block in Chief Architect has its own insertion point. You can precisely 
locate those insertion points using the method you just worked with. 

 

 

 



 

 
86 

 

 

CAN YOU DO IT? 
 

 

Using the blocks for the monolithic slab foundation on the right side of the D11.plan from the DVD, 
combine them to create the illustration shown in Fig. 1.18. 

 

PROBLEM EIGHTEEN 
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Step By Step Tutorial 
Chief Architect X4 introduced a new feature called 
Text Styles. Among its many other uses, this feature 
gives you more freedom in labeling CAD objects. 
 
 

 

The drawing, D12.plan, is used in the following exercise on displaying text labels for 
CAD objects, and can be found in the X9 Expert Drawings Before folder. If you have an older 
version of Chief Architect (X3 or newer) use the D11a.plan from the Older CA Drawings Before 
folder. Both of these folders are in the Advanced CAD folder. 

 

STEPS: Displaying Text Labels for CAD Objects 

1. Open the D12.plan (D11a.plan for older versions). 

2. Click the  Default Setting tool button to display the Default Settings dialog. 
3. Expand the CAD category. Double-click General CAD to display the CAD Defaults dialog. Note that 

for newer versions of Chief Architect there is no line label height setting. That is because the line 
label height setting for CAD lines displaying their labels is part of the text style feature. Click Cancel 
to close the dialog. 

4. Click Done to close the Default Settings dialog. 
5. In the drawing, in front of the model, there is a CAD polyline displaying its length and angle labels. 

Zoom in a little to the polyline. Double-click the polyline to open its specification dialog (Polyline 
Specification dialog). Go to the Line Style panel. Here you see that the DEFAULT CAD LAYER is 
displayed as being the layer for this polyline. Click the Define button. Note that the layer (in this case 
the DEFAULT CAD LAYER layer) determines the text style properties. In the Text Style column for 
this layer you see Default Text Style listed. This is the assigned text style for this layer. Each layer 
has its own text style. You can assign any layer a different text style if you choose. In the Properties 
for section, the text style can be selected from the Test Style drop-down list. 
 

CHAPTER 14 
Displaying Text Labels 
for CAD Objects 
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6. Click the Define button just to the right of the drop-down list for Text Style in the Properties for 
section of the dialog. The Saved Text Style Defaults dialog displays. Using this dialog you can edit, 
rename, and copy the selected text style. Click Cancel to close this dialog. 

 

7. In the Layer Display Options dialog find the layer, C-Anno-Site. Note that it has a different text style, 
the CAD Text Style, assigned to it. Select this layer to assign the layer and its assigned text style to 
the polyline. Click OK. 

8. Click OK to close the Polyline Specification dialog. Several things have changed. Double-click the 
polyline again to open its specification dialog. On the Line Style panel, click the Define button in the 
Line Options section. The Layer Display Options dialog displays. Click the Define button in the 
Properties for Selected Layer “C-Anno-Site” section. The Saved Text Styles dialog displays. Click the 



   

 
89 

 

Edit button to display the Text Style Defaults-CAD Text Style dialog. The text style is using a 
different Font. Italic is checked but you could use a different font style if you wanted by checking 
the appropriate check boxes. A larger Character Height of 10” is assigned. Note that you have 
Legacy Compatible Size and Transparent options. You can allow the Text Color to be chosen by the 
text style, which it is in this case, or you can check By Layer. The displayed color was chosen, which 
will display whenever the CAD Text Style is used. Click OK to close this dialog. 

 

You can now control the text style of CAD objects set to display length or angle or any text or 
number character. See Chapter 11 of the book Residential Design Using Chief Architect X8 
for a detailed description of the new text style feature. 

Line styles are somewhat unique in that you cannot control all of the text style attributes with a text 
style. For example, you cannot use text styles to control the size and color of the P/L line style 
displayed to the right of the model in the drawing. You can, however, control the font of the text 
included in line styles as well as the transparency of the text. 

9. Close the open dialogs. 
10. Double-click the P/L line displayed to the right of the model to display its specification dialog 

(Polyline Specification dialog). On the Line Style panel, note that the layer this line is on is the 
DEFAULT CAD LAYER. Its assigned text style is the Default Text Style. Select C-Anno-Site from the 
Layer drop-down list. As you know, the CAD Text Style is assigned to this layer. Click OK to close the 
dialog. Note that the text updated to the different font.  It would also assume transparency. The 
font color (brown for CAD Text Style), however, did not update.  

You can change the color for the entire line style from the specification dialog for the line style. 

11. Open the specification dialog for the P/L line. On the Line Style panel, the checkbox for By Layer is 
checked for Color in the Line Options section. This means that the line color is determined by 
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whatever layer the line is assigned with. Uncheck the checkbox. Click on the color bar to display the 
Select Color dialog. Select a different color. Click OK to close the dialog. 

12. Click OK to close the Polyline Specification dialog. As you can see, the entire line style (both the text 
and the line components) has changed to the color you picked. 

North pointers are also somewhat unique. They will take their layer text style, both font and color. 

13. The arrow on the left was made with the  North Pointer tool. Zoom in closer to the north 
arrows and double click the one on the left to open its specification dialog (Line Specification 
dialog). Go to the Line Style panel. You see that it has the DEFAULT CAD LAYER assigned to it. 
Change the layer to the C-Anno-Site layer. Click OK. The N label takes on the font and color of the 
layer’s text style. The arrow itself took on the layer’s assigned color. 

14. Click and drag the bottom edit handle to increase or decrease the size of the north arrow. Note that 
both the arrow and the text increase or decrease in size. So in this way the north arrow is unique. 

15. Select the arrow on the right, which is actually a CAD block brought in from the Library. Note that 
the symbol and the text are blocked together. Open the specification dialog (CAD Block 
Specification dialog) for the symbol. Go to the Line Style panel. The DEFAULT CAD LAYER is the 
assigned layer. Change the layer to the C-Anno-Site layer. Click OK. Nothing has changed. Chief 
Architect X4 – X8 will not let you change any of the attributes, including the font of the text nested 
in this particular CAD bock. To see how to change the text attributes, continue the exercise. 

16. Select the symbol and click the  Explode CAD Block edit tool button. Select the text, N, and click 

the  Object Layer Properties edit button. The Object Layer Properties dialog displays. Note that 
the text is on the A-Anno-Note Layer, which is using the Default Text Style. Click the Define button 
in the Properties for Selected Layer “A-Anno-Note” section. The Saved Text Style Defaults dialog 
displays. Click the Edit button to display the Text Style Defaults-Default Text Style dialog. If 
necessary, uncheck By Layer in the Text Color section. Click on the color bar to display the Select 
Color dialog. Select a color and click OK. 

17. Click OK to close the Text Style Defaults-Default Text Style dialog. 
18. Click OK to close the Saved Text Styles dialog. 
19. Click OK to close the Object Layer Properties dialog. Again, no change. 

20. Select the text, N. Click the  Convert To Rich Text edit button.  

21. Click the  Open Object edit button to display the Rich Text Specification dialog. Highlight the 

text. Click the  Color button and from the Select Color dialog select a color. Click OK.  
22. Click OK to close the Rich Text Specification dialog. You see the result.  In this case the block had to 

be exploded first, and then the text converted into rich text in order to control the attributes of the 
text.  
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23. Zoom in to the sun angle CAD object to the rear of the model. Note that this CAD object for the sun 
angle and the CAD object for the joist direction in the corner rear bedroom have the same text font 
and coloring as the text for the polyline we worked with earlier. That is because the layers that they 
are assigned to are all using the CAD Text Style that was also assigned to the layer we put the 
polyline on. 

 

     
 

24. Click the  Text Style Defaults tool button or display the Default Settings dialog. Expand Text, 
Callouts, and Markers, and then double-click Test Styles. The Saved Text Styles dialog displays. CAD 
Text Style should be highlighted. Click the Edit button to display the Text Style Defaults-CAD Text 
Style dialog. In the Text Color section, check By Layer. Click OK.  

25. Click OK to close the Saved Text Styles dialog. You see how the sun angle and floor joist CAD objects 
have updated. Also note that the polyline text also updated to the new default as well as the “N” in 
the north arrow on the left. 

Let’s look at the control you now have over arrow styles. 

The joist direction and the sun angle arrows both take their arrow styles from the default arrow style 
found in the Default Settings dialog. 

26. Display the Default Settings dialog, expand Text, Callouts, and Markers, and then double-click 
Arrow. The Saved Arrow Defaults dialog displays. The current default is Default. Click the Edit 
button to display the Arrow Defaults-Default dialog. From the Style drop-down list, select a 
different style of arrow. Change the color. When you are finished click the OK button for the Arrow 
Defaults-Default dialog to close it.  

27. Click OK to close the Saved Arrow Defaults dialog. 

Note Because of its ability to use multiple attributes in the same object, Rich 
Text does not use Text Styles. 

 

Tip When working with text styles you need to be aware of all of the objects 
that might be affected if you change any of the properties for that text 
style. 
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28. Click Done to close the Default Settings dialog. You see that the arrows do not update. The arrow 
defaults are static so that the ones already in the plan are not going to dynamically update. 

29. Select the sun angle arrow object and open its specification dialog (Sun Angle Specification dialog). 
Go to the Arrow panel and check the Default check boxes. Click OK. The arrow will now update to 
the default values. 

30. Click the  Joist Direction tool button and draw a joist direction line above the existing one in the 
bedroom. Note that it takes on the default values. 

Stairs and ramps have their own default settings. 

31. Display the Default Settings dialog; expand Stairs and Ramps, and then double-click Interior Stairs. 
The Interior Stairs Default dialog displays. Go to the Arrow panel. Select a different arrow type. 
Select a different color. When you are finished click the OK button. 

32. Click Done to close the Default Settings dialog.  
33. Go down to the foundation level, and select the stairs. Open their specification dialog (Staircase 

Specification dialog). Go to the Arrow panel and check the Default check boxes. Click OK. The arrow 
will now update to the default values.  If you were to draw new stairs they would display with the 
default arrow settings that you just made. 

 

CAN YOU DO IT? 
 

 

There are several ways that you can add detailed drawings to your construction plans using Chief 
Architect.  

 You can quickly add elements like basic concrete, wall insulation and siding patterns to a cross 

section view using the  Auto Detail tool. 
 You can obtain blocked detail drawings and components from the CAD Blocks section of your 

Chief Architect Core Catalogs or from the CAD Block and Details section of the Chief Architect 
Bonus Catalogs. You can use these details just as they are, or you can unblock them and edit 
them to get what you need. 

 Applying what you have learned in this section, and in the “Residential Design Using Chief 
Architect” books, you can use Chief Architect’s CAD drawing tools and create your own 
detailed drawings. 

PROBLEM NINETEEN 
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You can use any combination of the above resources. For example, you could generate a cross section 

view and begin detailing it using the  Auto Detail tool. You could then send the cross section view 

to a CAD detail view (using the   CAD Detail From View tool) that you could add a pre-made 
detail drawing to using the library, where, if necessary, you could unblock the detail, and edit as 
necessary. You could add even more detail using Chief Architect’s CAD drawing tools. 

This project exercise will test your knowledge on using Chief Architect’s CAD tools to create a new 
roof detail drawing. Your skills will also prove useful when you need to edit existing drawings. The 
skills you will need to apply in this project include:  

 Placing and editing components from the library 
 Drawing details manually 
 Positioning details accurately 
 Placing details in a cross section view 
 Adding your drawings to the library so that you can use them in other plans 

Develop the detailed roof drawing as shown in the following illustration. 



 

 
94 

 

       

 

Procedure Hints 
1. Take a cross section view through your building after framing the floor, ceiling, roof, and 

walls. 
2. With the cross section view active, select a framing set. 

3. Detail the cross section view using the  Auto Detail tool. 

4. Change the cross section view to a CAD detail view using the  CAD Detail From View tool. 
5. Find the CAD detail block you want to use in the Library (in the example used here, the 

Boxed In Eave detail was taken from the CAD Blocks section of the Chief Architect Core 
Catalogs). Select the detail block, move the cursor to your detail drawing and click to place. 

6. Unblock the CAD detail and edit as necessary. Edit the cross section view as necessary. 

7. Accurately place the CAD detail onto the cross section view using the  Point to Point 

Move edit tool and the  Select Insertion Point edit tool. 
8. When finished drawing your detailed drawing add it to the library so that you can use it in 

other plans. 
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